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FOREWORD

The Punjab Curriculum Framework (PCF 2013) which is based on National

Curriculum Framework (NCF) 2005 recommends that the child's knowledge must be
connected to their life outside the school, It indicates a departure from the legacy of
bookish leamning and ensures that learning is shifted from rote methods to activity based

learning and also provides an opportunity for the holistic development of the students.

Over the years, Computer Science as a discipline has evolved and emerged as a
driving force for socio-economic activities, Computer technologies are widely used in
diverse arcas of modern life such as education. business, health. transport and all other
sectors also. With the advent of computer and communication technologies, there has
been a paradigm shift in teaching at the school level, The role and relevance of this
discipline is in focus because the expectations from the school pass-outs have grown to
meet the challenges of the contemporary world. Today, we are living in an
mterconnected world where computer-based applications influence the way we learn,

communicate, commute or even socialise in day to day life.

Keeping in view these requirements. Punjab School Education Board has
introduced Computer Science as a compulsory subject from class 6th to 12th as per
guidelines of Punjab Government. Every effort has been made to include each requisite
information according to level of class 6th in this book. | hope it will be useful for
students and teachers.

This book focuses on the fundamental concepts and problem-solving skills
while opening a window to the emerging and advanced areas of computer science. The
newly developed syllabus has dealt with the dual challenge of reducing curricular load

as well as mtroducing this ever evolving discipline.

Punjab School Education Board welcomes and look forward to feedback and
suggestions for the improvement of its subsequent editions.

Chairman

Punjab School Education Board
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INTRODUCTION TO

m_’ ' COMPUTER

OBJECTIVES OF THIS CHAPTER

1.1, Introduction to Computers
1.2.  Applications of Computer
1.3.  Characteristics of Computers
1.4, Portable Computing Devices

1.5. Limitations of Computers

1.1 INTRODUCTION TO COMPUTERS

We see computers everywhere we go. There is no office or workplace where computer is
not used. Have you ever think the reason behind this? Why computers are so common now-a-
days? In this chapter. we are going to learn all these points. First of all. let’s understand “What is
a computer?”.

Computer is an electronic machine which makes our work easy and efficient. It accepts
data and instructions from the user and work on it as per instructions given. Working on data
according to instructions is called “Processing™. Alter the processing, the result is given to the
user as an output. S0, we can define computer as:

“Computer is an electronic machine that accepts data as input from the user and processes
this data under the control of set of instructions (program) and gives the result as an Output.”

Computer name was derived from the Latin term ‘computare’, which means “to calculate™.
In the beginning. it was used for calculations only. As per the development in electronics field, it
became such an all-round machine.
1.1.1 Uses of Computers
We can use computer for these purposes:-

i.  We can do mathematical calculations on computer,

ii. We can play games on computer.

lii. We can draw pictures on computer.

iv.  We can listen songs and watch films on computer.

v.  We can use computer to print books and newspaper.
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vi. We can use computer to book our tickets to travel in Trains. Buses and Airplanes.

vii. We can check arrival and departure time of Trains, Buses and Airplanes with the help
of computer.

viti. We can check the weather conditions of any place before travelling.

ix. We can print reports, results of our school or time table,

x.  We can store our data into computer for future use.

1.2 APPLICATIONS OF COMPUTER

Applications of computer mean use of computer in different fields. Some of the fields are

as follows:
1.2.1
.22
1.2.3
1.2.4
(25
1.2.6
1.2.7
1.2.8

1.2.9

Education
Entertainment
Sports
Communication
Shops

Hospital

Banks

Government Offices

Travel

1.2.1 Education

Computers are used by students and teachers in education field. Students use computer to
prepare notes, drawings, making projects etc. They use internet for study material and use of
E-Contents. Teachers use computer to prepare results, Time table and reports. Computer is also
used for keeping student records, online data processing on web portals, like www.epunjab
school.gov.in,www.pseb.ac.in etc.

Fig: 1.1 Use of Computer in Education
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1.2.2 Entertainment

Computer is a good source of entertainment. We can watch movies, listen songs and play
games on computer. We can enjoy virtual 3D effects with the help of computer. New stories and
Tunny aects can also be represented in the form of cartoons. This kind of computer generaled
multimedia presentations are a good source of entertainment. This field plays an important role
in play-way method of studies.

Fig: 1.2 Use of Computer in Entertainment
1.2.3 Sports
Computer 15 being used in sports field to improve the performance of players. Record of
player’s daily data is stored in computer to maintain good performance. Some outdoor games
are played in virtual 3D station for practice. Players can have their movements recorded to
improve running, start-up and jumping related games. Digital scoreboards are also a part of
every game today.

Fig: 1.3 Use of Computer in Sports
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1.2.4 Communication

Communication means to contact or contacting someone or a computer which is away
from us. We can use computer for this purpose for more advanced type of communication., With
the help of computer, we can have interactive Video calls. We can control one device or computer
from any remote location. We can also create a personal network for any personal communication.
Digital devices like Smart Phones, Tablets, Laptops and Computers can share any type of data
through these networks.

Fig: 1.4 Use of Compuier in Communication
1.2.5 Shops

Shop 1s a common workplace where we see the computer. Shop keeper has to manage the
stock of each item available in shop all the time. It is required to generate purchase orders for the
items which are sold out. This work was very difficult before the use of computer. Now, each
sold 1tem is being recorded in the computer. The present stock in the shop and daily sale of the
items can easily be managed,

Fig: 1.5 Use of Computer at Shops
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1.2.6 Hospital

In hospital, patient record is stored in computer. It is easy to monitor the health of each
patient. The medicine history of patient and effect of medicine on patient’s health can be monitored.
This data about each record can easily be shared among different hospitals. This data can also be
used by researchers to create effect list of each medicine on patient’s health. Computer can also
be used in laboratories to do complex test analysis.

'

Fig: 1.6 Use of Computer in Hospital

1.2.7 Banks

Bank is a place where each work is related with data manipulation. Most of the entries are
related to withdrawal of money from the account or deposit of money into the bank account.
Each of such an entry requires a lot of data processing work. Computer is a best option for such
calculations and processing of data. All the accounts can easily be managed using computers.
The use of ATMs also became possible only with the help of computer.

Fig: 1.7 Use of Computer in Banks
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1.2.8 Government Offices

Government offices do work related to the services for citizens. All these services are
mainly related with E-Governance, Bill Payment, Income tax, Application processing etc. With
the help of computer and internet. most of the services are now online. We can apply for any
application by sitting in our house. We can also pay bills with the help of internet-banking using
computer or smart phones. This use of computer changed the working of Government Offices.
Most of the Government services are available 24 X 7 with the help of Internet.

Fig: 1.8 Use of Computer in Government Oflice

1.2.9 Travel

Travelling is part of every business and office work, We often travel for the purpose of
research work, sale or purchase, personal meetings, site-seeing etc. Travelling requires knowledge
of the geographical areas, availability of means of transport, cost estimation and regional culture
etc. With the help of computer, all these tasks become very easy. We can get relevant information
through Internet by sitting in our room. We can also book our means of transport and staying
places, This kind of travel related facilities made travelling very easy and safe. It could be possible

with the help of computer only.

Fig: 1.9 Use of Computer in Traveling
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1.3 CHARACTERISTICS OF COMPUTER
Computer is very popular because ol its characteristics. Each of these charactenstic
encourage the use of Computer over manual working. These characteristics are as follows:

1.3.1 Speed
1.3.2  Accuracy

1.3.3  Reliability
1.34 Diligence
1.2.5 Automation

1.3.6  Storage
1.3.1 Speed

This is the most important reason behind use of computer in every field. "Speed” means
how quickly, a work is done. Computer performs each of its work very fast. It completes a
complex calculation in fraction of a second. It is several times faster than human, Time taken by
computer to do a work can be measured in 1000th part of a second. This very short time is
known as “Millisecond™,

1.3.2 Accuracy

Computer’s Speed is not only an advantage of it. Its accuracy is also very important
characteristic. By the term “Accuracy”, we refer to the correctness of result produced by computer.
Human can perform fast calculations too, but when it happens then mistakes increases, Computer
do fast calculations with 100% correctness of result. This feature of computer is known as
"AI:.:E:UTEI.C}’".

1.3.3 Reliability

Rehability refers to “ability of being trusted”. Computer is very fast in calculations or

other data manipulations. We can trust on its result for 100% accuracy too. This makes the

computer reliable. We need no re-checking of the result produced by the computer. However, the
program we dare using must be tested and error free.

1.3.4 Diligence

As per the nature of human, the correctness and working speed get down with regular
working for a long time. This is not same in computer. Each computer performs first and last
task with same speed and accuracy, Computer never get stired as human does. Computer can
work correctly for years.

1.3.5 Automation

Computer performs the whole task as it 1s programmed to do. It needs no interaction during
the processing. [t requires a set of instructions before beginning of any task. When it got a
complete and accurate program of doing any work, it can automatically perform the operations
till the end and gives the result to the user by its-self.
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1.3.6 Storage

Computer’s storage capacity is very large. Each computer is having Hard Disk Drive attached
within it. This device stores huge amount of data of any type. It can store text. audio, video.
programs, animations etc. as a data within it. We can easily find and retrieve the stored data from
the computer whenever required. Data remains separate and safe for a long time.

1.4 PORTABLE COMPUTING DEVICES

All devices which are used to process data and can easily be carried with us are called Portable
Computing Devices. We can use several devices for this purpose. Let's discuss some of these

devices:
1.4.1 Mobile (Smart Phones)

This is a common Portable Computing Device widely being
used. Mobile is a hand holding device which is able to make calls
and process data digitally. Smart Phones are available with camera,
large storage capacity and very fast processing speed. We can use
mobile phone for different purposes in education. business. trading,
entertainment and gaming. This device is small enough to be carried
in our pocket and easily be operated in hands. There is a variety of
maobile phones available now a days.

1.4.2 Tablet Computer

It is a very thin portable computer. It is usually battery-
powered. It has a touch screen as a primary interface and input device.
It doesn’t have a physical keyboard and lid. It can be used for several
purposes, where less character data 1s o mput. We can see this
computing device at shopping malls, restaurants ete.

1.4.3 Palmtop Computer

As per its name, palmtop computer is small enough to place
at our palm during its use. It is a computer that has a small screen
and compressed keyvboard. It is often used as a personal organizer.
This device is not so popularly being used because 1t has limited
applications.

1.4.4 Laptop Computer

This computer is a part of almost every field of computing.
This small and light weight computer is available with wide screen
and full size desktop. It is also having touch pad on it to fulfil the
need of mouse. We can work on this computer by placing it on our
laps. This is why such type of computer is called “Laptop™. All the
programs and applications are able to be executed on this type of
compulter.

Fig: 1.10

Fig: 1.12

Fig: 1.13
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1.5 LIMITATIONS OF COMPUTER
Computer is capable of doing a lot of works. But, after all this is a machine and unable to
do some tasks. These kinds of tasks are considered as limitations of computer. Some of the main
limitations of computer are as under;

* A computer cannot take decisions by itselfl.

* A computer cannol correct wrong instruction.

*  Computer cannot do any work without instruction from the user.

* [t does not have feelings or 1Q (Intelligence Quotient)

* It does not have knowledge and experience like a human being.

Points To Remember >

Computer is an electronic machine that accepts data as an input from the user and
processes this data under the control of set of instructions (program) and gives the result as

an Qutput.

Computer is used in the fields of Education, Entertainment, Sports. Banks, Hospitals,

Communications and Health.

Computer is very fast, accurate, reliable and automatic machine.

Computer cannot take decisions.

Computer needs instructions for every work., It cannot do anything by its own.

@ T ExXERCSE)

Multiple Choice Question
I. Computers can do

A, Calculations B.
C. Storage D.
Il. Computer performs its operations with high

A. Speed B.

C. Efficiency D.
IIL. In banks, computer is used for:

A.  Keeping the bank safe B.

C.  Keeping bank clean D.
I'V. In Education, A computer is used for:

A.  Preparing Noies B.

C.  Prepanng Reports D.

InTrRODUCTION TO COMPUTER

Accept data and instructions

All of above

Accuracy
All of above

Keeping Account records.

MNone of these

Preparing Result
All of these
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V. Which one of these is a limitation of Computer:
A, Speed B.  Accuracy
C. Nol) D. Duligence

Write trne /false

I. We can use computer to book tickets of train & airplane.

II. Computers cannot do calculations with 100% correciness.

III. Data stored in computers remain safe for a long time.

IV. Computers donot have feelings or IQ).

Fill in the blanks :

I. Computer is an ............... machine.

II. Mobile isa .. device.

IIL Time taken by computer to do a work can be measure in ... A

IV. .oeveeereereeeneen. als0 have touchpad to fulfill the need of a mouse,

Short Answer Type Questions

I. Define Compulter.

II.  Explain the uses of computer in Education Field?

[1l. Write the name of any three Portable Computing Devices.

Long Answer Type Questions

I.  What are the Characteristics of Computer?

II.  Define any 5 applications of Computer.

11, What are the limitations of Computer?

IV. What do you mean by Portable Computing Devices? Explain any three of them.

V. Explain the uses of computer.
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COMPUTER

m COMPONENTS

OBJECTIVES OF THIS CHAPTER !

2.1 Introduction to Basic/Standard Components of A Computer System
2.2 Block Diagram of Computer
2.3 Types of Computer Memories

24  Categories of Computers

2.1 INTRODUCTION TO BASIC / STANDARD COMPONENTS OF A
COMPUTER SYSTEM

We have learnt that “what 1s a computer and what are its uses™. We have also studied about
some popular fields where computers are used. All the characteristics of computer have also
been studied, which clarifies why computer is used in almost every work we do.

In this chapter we are going to learn aboul the components of computer. First of all let’s
have an introduction to standard Input/ Output devices. Here you must be thinking about “What
are standard Input/ Output devices!™

Standard Input/ Output devices are those devices which must be attached with CPU to
operate a Computer System. We can have a look of standard Input/ output devices as follows.

Central Processing Unit
(CPU)

N\ Manitor/LCD

Kayboard

ComruTeER COMPONENTS 11



As shown in Fig 2.1, standard input devices are Key-Board and Mouse, Both these devices
are essentially required to operate a computer system. If keyboard is not attached to computer
then computer displays an error message for the same, Keyboard is a text input device and
Mouse is a pointing device. Monitor /LCD are known as standard output device. Any one of
them is also required essentially. Without this device, we cannot see, what is going on a compulter
system. These standard input /output devices are very important components of a computer
system.

2.1.1. How computer works:

The way of processing within a computer system is called “Processing Cycle of a Computer™.
We can represent processing cycle of a computer as given bellow:

(i) e (Foss) e

Fig 2.2

As we can see in above Fig 2.2, processing of a computer system can be presented in three
terms. Let's firstly understand the parts of IPO (Input Processing Output):-

I. Input : This part of computer’s processing cycle is related with input of data and
instructions into the computer. As we know, computer is an electronic machine and each instruction
is processed electronically within a computer system. This tvpe of data processing is different
than human understanding. To work on computer, human understanding form of data must be
changed into electronic form. This type of conversion is done by Input components. For each
different type of data, we use different type of Input devices. For example, keyboard is used to
input text data, Mouse is for poinling on screen or free hand drawing, microphone for
sound input ete.

1. Processing : Implementation of the given instructions on input data is called
“Processing”, This is a main function of computer. During processing, several arithmetic and
logical operations take place. This role is performed by micro-processor installed within a
computer system. This central part of processing cycle of a computer is being performed by
Central Processing Unit (CPU). We will learn this part of computer system in detail in next
section of this chapter.

1. Output : After the completion of processing, the produced result is given to user
through Output unit. This unit of a computer svstem does exactly opposite of input unit. Devices
used for output purpose converts electronic data to human understandable form. Some examples
of output devices are Monitor/LLCD (Liquid Crystal Display), speaker, printer etc.

All these terms collectively made a computer system complete for processing our instructions.

2.2 BLOCK DIAGRAM OF COMPUTER

Block diagram of Computer refers to the layout of attachment of all components within a
computer system. We can have graphical representation of this layout in the form of block diagram.
Block diagram of computer is given below:

12 CoMruTER SCIENCE
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Block Diagram of Computer

We have already studied Input Unit, CPU and Output Unit of computer system. Let’s
understand the part of Central Processing Unit (CPU) in detail.

2.2.1 Parts of Central Processing Unit

Central Processing Unit of a computer system can be divided into three parts:-

I, Memory Unit (MU)

1I.  Control Unit (CU)

L. Arithmetic Logical Unit (ALU)

I. Memory Unit : Memory Unit of a computer system is also known as “Storage Unit™. It
holds data and instructions in computer system. There are several types of memories. Each of

them is having its different role to perform. Their size, storage capacity, nature of operation and
speed make them different from each other.

[l Control Unit : The control unit is the brain of computer. It performs all the operations
given in the form of input instructions or programs. It also controls the functioning of all other
components of computer. It accepts all the instruction from input unit and generates series of
control signals according to the input instructions given. These Control Signals then operate the
other parts of the computer. This 13 the main function of Control unit.

I1L Arithmetic Logical Unit (ALU) : This is a core component of computer CPU. As per
its name, it performs all the arithmetic and logic related tasks during processing. In digital
computer, all the operations are performed logically and contain a lot of calculations to be
processed. Processing of arithmetic operations and all logical operations like AND, OR, NOT
etc, are done by this part of CPU. This part of computer system is integrated within the “Micro-

processor’ .

ComruTeER COMPONENTS 13



2.3 TYPES OF COMPUTER MEMORIES

We have already discussed the Memory unit of Computer System. Computer memories
can be classified in following two types:
*  Primary Memory

*  Secondary Memory

2.3.1 Primary Memory

Primary memory is also known as main memory of Computer System. It is directly
accessible memory by Microprocessor which is a control unit of CPU. All the instructions and
data must be present in primary memory before processing. This memory is also known as main
memory of computer. There are two types of primary memories used within the computer.

RAM (Random Access Memory) : This primary memory is the main memory of computer.
It is very fast memory of computer. All instructions and data are stored here during processing.
This memory is volatile in nature i.e. all contents stored in this memory are lost when power
roes off. This device cannot hold data permanently.

ROM (Read Only Memory) : This memory is a permanent memory attached on the
motherboard of computer system. Content stored in it cannot be changed as it is read only memory.
This memory hold instructions and data required for computer system to start. No write operation
is allowed on this memory.

2.3.2 Secondary Memory

Secondary storage 15 called auxiliary storage. It is a permanent memory of computer system.
As we studied earlier, primary memory RAM is not permanent and ROM do not allow user to
store any data on it. So, to provide permanent storage in computer, we use secondary storage
devices. This memory 15 not directly accessible by the processor. It is for storing data not in
active use. So it is called non-volatile memory. In a personal computer, secondary storage typically
consists of hard disk drive and many removable media like CD, DVD or USB Pen Drive etc.

2.4 CATEGORIES OF COMPUTER

We can categorise computer according to their Speed. Memory, Processing Capabilities
and Storage Capacity. We have following main categories of computer.

24,1 Micro Computer (Personal Computer)

24.2  Mini Computer

2.43  Mainframe Computer

244  Super Computer

2.4.1 Micro Computer (Personal Computer)

Micro Computer (Personal Computer) is the most
common type of computers used nowadays. This type
of computers are having common storage capacity and
processing speed. The cost of this type of computer 1s
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very less, These computers are affordably used in small business. small offices. schools or other
workplaces.

2.4.2 Mini Computer

This type of computers has greater features and
processing capabilities than of Micro Computers. These
computers are used in the field where multiple users
are required to work together. Storage capacity. sharing
of resources and processing speed of this type of
computer is higher than micro computer. Minicomputers
are mainly used as small or midrange servers. This type
of computer 1s used in large business, large team based

companies, scientific applications etc.
2.4.3 Mainframe Computer

These computers are capable of handling and
processing very large amounts of data quickly. These
Computers are capable of performing operation on large
amount of data with high processing speed. Mainframe
computers are used in large institutions such as
government Offices, banks and large corporations.

2.4.4 Super Computer

A super computer is most powerful computer. It
has fastest speed and very high processing capabilities.
It has laree data storage. Super computer is specifically
used for complex applications in big organization. Super
computers are the most powerful and very expensive.
The application areas of this type of computer are
weather forecasting, climate research. oil and gas
exploration etc.

Poimts To Remember >

1.  Keyboard and Mouse are the standard Input Devices of computer.

]

Monitor/LCD is the standard Outpuot Device of Computer.

3 Computer’s processing Cycle 1s Input-Process-Output.

4. Memory unit, Control unit and ALU are the components of CPLI.
5. Compuler accepts data and instructions through Input Unit.

6.  Computer gives the result through Output Unit.

7. Computer process the given instructions through CPU and produce the result.

ComruTeER COMPONENTS 15



1.

12.
13.

16

CPU can be divided into three separate units. They are:
a.  Memory unit
b. Control unit.

c.  Arithmetic logical unit

The control unit is a brain of computer which performs the processing of instructions.

Memory directly accessible by CPU is also called primary storage.

Permanent storage of computer is called Secondary storage or auxiliary storage.

Computer used at home or small business is called Micro-Computer.

Super Computer is the most powerful computers.

(EXEReBE)

Multiple Choice Question:

1. Which part of computer system accepts input from the user?

A.  Input Unit B.  Output Unit

C. Control Unit D. None of these
II.  Which is a part of CPU?

A,  Control Unit B. Memory Unit

C. ALU D.  All of above

[1l. Which memory stores permanent data in computer system

A, Primary Memory B. RAM
C.  Secondary Memory D, All of above
IV. Which is a most powerful type of computer.
A.  Mainframe Computer B.  Mini Computer
C.  Micro Computer D.  Super Computer

V. Which part of computer system gives result as an output to the user:

A, Memory B.  Input Unit
C. Control Unit D, Output Unit
Write the full forms:
I. ALU 1. CPU
. LCD IV. RAM
V. ROM VI, CU
VIIL MU, VI, TPO

CoMruTER SCIENCE



3.  Short Answer Type Questions

I.  Write the name of parts of CPU.,
I1.  What are the types of memories?
HI. What are Secondary Storage Devices?
IV. What is the function of ALU?
V.  What is Micro-Computer?
VI. What are different categories of Computers?
4. Long Answer Type Questions
1. Explain primary memory and iLs types.
II. How Computer Works? Explain each term in details.

Write the given Items in their respective Category:

3
5
7.
¥}

RAM 2. Keyboard
Mouse 4. ROM

Hard Disk Drive 6. Printer
Microphone 8.  Speaker

LISB Pen Drive 1. Monitor/LCD

Primary Memory Secondary Mﬂmnrﬁr

wr W

Qutput Devices Input Devices

ComruTeER COMPONENTS
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BASIC OF WORKING

OBJECTIVES OF THIS CHAPTER

31 Operating System

32  Starting Compuier System

3.3 Desktop and Its Components

3.4  Working with Windows Applications
35  Shuiting Down Computer System

INTRODUCTION

We have learnt the components of a Computer System in previous chapter. A Computer
System is a combination of hardware and software. All the components learnt so far are the
hardware components, These hardware components can do nothing without software. We will
learn the categornies of software later in this class. In this chapter, we are going to understand the
importance of most important software of a Computer System. This software is called “Operating
system’”, Let’s understand the importance of this essential part of a computer system.

3.1 OPERATING SYSTEM

System software which helps in operating a device or hardware is called “Operating System”
It’s main function is to provide an interface to work on a machine. Not only in computers, all the
digital devices like Mobile Phones, Tablets, I-Pads are having operating sysiem installed in it
This software creates an interface between machine and user so that operations can be performed.
For example, our mobile is having home screen, menu, dialog boxes. icons and widgets to create
an interface. Similarly, each computer is having desktop, icons, Menus and other control for the

working on it. All such kind of controls are created and managed by “Operating System-08".
Let’s define OS.

“An Operating System is an interface between a Computer user and Computer
hardware. It makes a computer hardware working by controlling all the internal
processes of a computer™

Operating Systems are of several types. Each different digital computing device is having
different operations to perform, So, as per the requirements of a device, operating system can be
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designed differenily. For example, an operating system of a Computer is ditferent than of Mobile's
OS. There are several examples of Operating Systems. Windows, Macintosh, Linux, DOS,
Android. Symbian, etc. are some of them. Let’s discuss about some of these.

3.1.1 Windows

Windows is an Operating System (OS) designed by Microsoft. Tt provides Graphical User
Interface (GUI) and user can sasily operate computer with the help of a mouse. When we click
on a program in window, it opens in 4 frame hike a window. Thatl 18 why il 18 named as
WINDOW.This operating system is most popular due to its easy to operate and have good graphical
conlrols.

We will study working on Microsolt Windows 7 uliimate edition in next section of this
chapter.

3.1.2 DOS

Disk Operating System (IDOS) is also designed by Microsoft. Tt is a traditional Operating
System. It provides Character User Interface (CUT) for working on a computer systerm. This
Operating Svstem was used when computer was not so powerful. This operating System was
able to run on a computer with small memeory and slow speed hardware. This Operating Sysiem
was difficult to operate.

3.1.3 Android

The Android operaiing system is used in hand holding devices such as mobiles.
This was developed by Google (GOOGLE). This OS is primarily used for touchsereen devices
like cell phones and tablets. This interface can be used with finger’s common motions such as
pinching. swiping, and tapping. Now-a-days, Android OS is also being used in televisions. cars.
and wrist watches. Each of these devices is having different user interface.

3.2 STARTING COMPUTER SYSTEM

We have studied the role of Operating System.
When we switch-on the computer, OS installed into a
computer get loaded and makes a computer ready to
operate. In this section we will study the steps to start
a Computer System.

3.2.1 Powering On

When computer is already powered-off then we o
firstly SWITCH-ON it. For this purpose, we can press
Power-Button of CPU. Monitor/LCD is antomatically
controlled by CPU it-self. When Power-Burton i3 on then Monitor/LCD is activated and display
appears. But, if Monitor/LCD is Powered-OFF then it requires to being Powered-On explicitly.
We will press the power Buttons accordingly. The process of Booting begins, which starts the
computer. After booting the following screen will be displayed.

Fig. 3.1
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Fig. 3.2
3.2.2 Logging In

After the booting process. Login Screen of Windows 7 is displayed. Window provides
security of data stored within it. This screen is to validale the authentcity of user starting the
computer. Window offers the partiioning of data among different users. From this screen, we
can enter into our anthorized logins. It shows the different nsernames and each of them can be
differently password protected.

The number of users, User Names and Password of each user can be different from computer
o computer. When we want to access computer in our Computer lab for first time, we can ask
the username and its password from our teacher. When username and password is given, we will
click on the username and new screen will appear.

Fig. 3.3

On this screen, we will enter the password given by our teacher. The password is never
shown when typed, Only Dots or Stars displayed to show the count of characters entered. Just
enter your password carefully and press the Arrow Button or hit Enter key.
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If password entered by you is correct then login process is completed and desktop of
computer start displaying. This very first screen of computer is consists of several items on it.
Let's discuss these iiems displaying on deskiop.

3.3 DESKTOP AND ITS COMPONENTS

After log in the very first screen displayed on computer is called "DESKTOP”.
This screen is a dashboard of Computer System. We can start any program and perform other
basic operations from this screen of computer, Desktop of a computer and its parig are as per
given bellow:

lcons Wallpaper Task Bar
Fig. 3.4 Deskiop of Microsoll Windows 7 and s parts

3.3.1 Icons
Icons are small pictures on desktop. Icons act like a bution to access .
a program, folder or file. To open a folder or file,we have 1o click on its icon
twice. This operation is called “double click”. Some examples of icons -
showing on Desktop are as under: -
i. My Computer : Thisicon is used to access all the HDD drives, Com puter
removable media or other places present in a computer system,

When we click on this icon, a new window opens and all items
can be accessed by double clicking on them.

ii. Network : This icon is used o access a Network Locaiion. This
icon is used when a Local Area Network (LAN) 1s designed and
our computer is connected to it. We can share our data and other
resources through thig icon. All the connected computers can be
accessed from this icon too.
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iii. Recyele Bin : This icon looks like a dust-bin, It works like a
dust-bin also as it contains all the deleted files, folder, icons,
etc.When we delete any item than it is moved to recycle-bin by
default. It we delete any item accidentally then we can restore

the deleted item from recycle-bin any time.

iv. User's Files : This icon is used 1o access the current user data. Tt
holds all the default locations for different types of files. For
example My Documents, My Pictures, My videos. Desktop ete.

This icon is named as user name of currently running user. In the School

icon showing here, “School™ uger name is currently login.

3.3.2 Shortcuts

A shorteut 1s an icon that represents a link to a program, file, folder or
other item. I we want easy access from desktop to our favourite files or
programs, we can create shortcuts of them. We can run a program or open a

file/folder by double clicking on its shortcut. If we delete a shortcut, only m
the shortcut is removed, not the original item. When a new shorteur is created winword =

then its icon automatically start showing the original item’s icon, but a small Shortcut
arrow on it. We can identify shortcuts by this arrow on their icon.

3.3.3 Wallpaper

Wallpaper is an image displaying behind the graphical user interface on user's desktop. It

is also called a desktop background. Tt can be a picture, colour or pattern. We can choose the
picture, colour or pattern for wallpaper according to our choice. There are some pre-loaded

wallpapers available in the desktop background gallery of our Windows 7. We can change

wallpaper of our computer using following steps:
Changing Wallpaper:
i. Right-click on wallpaper displaying on
Deskop.

ii. Choose “Personalize” option from popup
menu appeared.

iii. A new window will appear.

iv. Select required theme from the window. We
can alternatively click on “Desktop
wallpaper™ option from the bottom and
choose the wallpaper.
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Fig. 3.6 Desktep Personalize Window

3.3.4 Taskbar

Taskbar is usually located at the bottom of the screen. This bar is a part of Operating System. It
allows us to start a program using Start menu. This bar always remains visible during working in
any application. We can navigate thorough Active programs using taskbar. The area on the right
side of the taskbar is called “Notification Area”. This area allows us to check date and time.
items running in the background etc. The askbar first introduced with Microsolt Windows 95
and 1s found in all subsequent versions of Windows. We can have a look of taskbar and it’s all
parts as under:

Clock &
Date

Start Button 450k launch Icons Motification Area

. L omg Ty

System Tray  Show Desktop
Active Programs

Fig. 3.7

All these parts of taskbar are having their own function. Let’s discuss the use of cach one
of them.

i. Start Bulton : We can start any application and program with the help of Start button.

It is the first item on Taskbar. It's icon is E - Itis having logo of windows on it.

Basic o Wornmne Wit CoMPUTERS 23



iii.

iv.

vi.

Quick launch Bar : This section of the taskbar enables us to launch programs without
locating them from Start menu. It is located next to the Start button.

Swstem Tray : It is located at right side of Taskbar. It contains miniature icons for
easy access to system functions such as fax, printer, modem, volume etc,
Notification Area : This area is a part of the taskbar that provides notifications and
status of devices. It can also be used 1o display icons for system and program features
that are not on the desktop.

Clock : At the end of taskbar, Clock is displayed where Current time and Date can be
scen. We can change Time and Date by clicking onit. It requires administrator rights
to change the Time or Date.

Active Programs : This area of taskbar is between quick access bar and System Tray
area. In this area of taskbar, all the aciive programs appeared as an icon and we can
easily navigate among them.

3.4 WORKING WITH WINDOWS APPLICATIONS

Microsoft Windows 7 provides some of the inbuilt applications which are used for different
purposes. These applications are most basic applications and each one 1s of different type. Let’s
discuss some of these applications.

3.4.1 Notepad

Thiz is a basic text editor of Microsoft Windows. This is mainly used to type character
data. Tt is the most simple applications for creating files with text data only. This application is
mainly used for writing codes (Source Files) of programming languages like HTML, Java etc.

(oo (5] [Bn] g =
i
T Ui - i =
i 2 B o e =
-

Status Bar

Fig. 3.8 Parts of Notepad Window

Running Notepad:

Start — All Programs — Accessories — Notepad
OR

Click on start bution and type “Notepad” in scarch bar. Click the Icon form the list and
press enter key.

24
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3.4.2 WordPad

This is a Rich Text Format word processor. We can create a document with formatting
using this application. This application can be used to write letters or to create documents with
texts data only. Graphics like chart, pictures, clip-art etc. cannot be inserted in it.

= & a IR E- R
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3.9 Parts of WordPad Window
Running WordPad:
Start — All Programs — Accessories — WordPad
OR

Click on start button and type “WordPad” in search bar. Click the Tcon from the list and
press enter key.
3.4.3 Paint

This is in-built graphical applications of Microsoft Window 7. We can create drawing or
other basic graphical objects using this application. Tt is also known as MS Paint. Ms Paint has
several tools for drawing and colouring. We can edit an existing picture also using this application.

Min‘lmizaL [E‘Eturei Close

L‘!
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Fig 3.10: Parts of Paint Window
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Running Paint:
Start — All Programs — Accessories — Paint
OR
Click on start button and type “Paint” in search bar. Click the Icon from the list and press
enter key.
3.4.4 Calculator

This application of Microsoft Windows 7 is used to do calculation related work. We can
uge this application as we usge real calculator. Tts layout and buttons are also similar to real
calculator. We can perform calculations up o 16 digits using this application.

View Edit Help

luleniu bar

e [ ee [ s || e | e
=l e]l= ]l

Fig. 3.11 Parts of Calculator
Running Calculator:
Start — All Programs — Accessories — Calculator
OR

Click on start button and type “Calculator™ in search bar. Click the Icon from the list and
press enter key.

3.4.5 Using Run Box

Run box allows the user to open a program by name. This opton of windows is very
useful for fast opening of programs. Instead of navigating though menus, we can directly
type the name of program to run. Each program exigts in computer as an executable file, For
example, MS Paint is named as “pbrush”, Notepad as “notepad”, WordPad as “Wordpad™ and
Calculator as “Calc”. We must write correct name of that program which is to start. We can also
start any file by typing it's full path. The picture below shows how the Run box looks like in
Microsoft Windows 7.
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Type the name of 2 program, folder, document, or Internet
resource, and Windows will open it for you.

Open: | =
@ This task will be created with administrative privileges, 1

ok | Concel || Browse. |

Fig. 13.12 Microsof{ Windows 7 Run Box
Using *“Run-Box" in Micreosoft Windows 7:
To open Run Box in Microsoft Windows 7, we can use following steps.

Press Window E button + R together.

OR
Click on start button and search for “Run”. Click the Tcon from the list and press enter key.

3.4.6 Search Box of Start Menu

We can use Scarch Box of Microsoft Windows 7 to search file or programm our Computer.
It can find given file from hard drive. It is located at the bottom of Start Menu of Windows 7. If
this bar is missing from the start menu then we can re-enable it from Control Panel. The Search
Box of start menu look as given in the picture bellow.

D Prograins
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If this this part of start menu is missing then we can use following steps to show Search
Box.

Steps to show “Search Box™:
i.  Open the Stari menu and click "Conrol Panel.”
1. Click "Uninstall A Program" under Programs.
iii. Click "Turn Windows features on or off."
iv. Click on checkbox named "Window Search”.
v. Click "OK" to save your changes.

Search Box will start showing in Start Menu after restarting our computer.

3.5 SHUTTING DOWN COMPUTER SYSTEM

Shutting Down a computer is process of tming off the computer system when all our
work is over. This process is very important because if shutting down is not properly done. our
data can get lost. Improper Shut-down can also canse corruption of Operating System.
When our work is completed and we want 1o leave the compurer then following are the options
that are available in the Shut Down menu. We can choose any of them as per our requirement.
These Options are as under:

Fa

All Programs = Power Menu Option

3.5.1 Sleep

This option of Power Off menu can be used when we want to leave a computer for some
time. During this mode, The power of Monitor/LCD get OFF and all your data is kept safe.
When we put a compuier into sleep mode then its power remains ON and its power light start
blinking. This blinking Red-Colour LED on CPU shows that computer is in sleep Mode. We can
press power button to resume computer from this mode.

3.5.2 Shut Down

This option of Power menu can be used when we have finished all our work. When we
shut-down a computer, all parts of computer systemns are turned off and no power remains active
in the Computer System. We can switch off the main power-supply of computer when it is shut-
down. This process can take some time and we must wait till it is over. This process may take
time according to the size of data being used and number of programs currently running.
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3.5.3 Log Off

As we have studied in this chapter that Windows 7 allows us to access a computer differently
among users. We can keep our data secure from other users with the help of user accounts in it.
If we have finished our work and want to leave a computer but another user is there to access the
same computer for own work in different user account then we can use Log-off option of power

Menu.,

3.5.4 Restart

This option of power menu can be used when any new program is installed or any updation

in the system is done. Some time when new device or hardware is attached with computer and it
is required fo restart our computer. In such case, we can use restart option of Power menu to shut
down our compulter and start it again, When restart button is pressed then computer automatically
get started after being shut-down.

et R O L Sl il

o
=

Screen appeared after login is called Deskiop.

Small pictures representing programs, files and folder on the desktop are called Icons.

My computer icon is used to access local Drives and other places.

All the Delered files are stored in Recycle Bin.

Task bar is displayed at the bottom of desktop and shows all active programs.
We should shut down the computer properly instead of direct Power OIf.
We can use Network Icon to share data among computers on LAN.

Shortcuts are the links to file or programs used for fast access.

Wallpaper is a picture or colour displaying on the deskiop background.
Each user can secure valuable data with the help of username/Password.

@%@Eﬁ%@@ﬁ )

Multiple Choice Questions :

1. Screen appeared after login of Computer is called:

A, Start Menu B. Deskiop
C. Taskbar D. None ol these
1. All the Deleted files go to?
A, My Computer B. Network
C. Recycle bin D.  All of above
II. Which part of window remains visible all the time when we use other applications?
A. Recycle bin B. Deskiop
C. Taskbar D.  None of these

Basic or Wornmwe with COMPUTERS
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IV. Which one is an example of Operating System:

A.  Windows B. Android

C. DOS D.  All of above
V. To open a file we can double click on:

A.  File itself B. Shortcut of file

C. BothAandB D. None of these

Fill in the Blanks :
1. Small picture representing programs, files and folders on the desktop are called.........

| | e is an interface between a computer user and computer Hardware.

IIL operating system is a mobile operating system.

IV. A.....ccoovverennn 18 an icon that represent a link to a program.
Wesunmnnnii is a basic text editor of microsoft windows.

Write True or False :
1. Window is an operating system designed by Microsoft.
II. Dos provides graphical use interface (GUI) for working an computer systen.
11I. Task bar iz usually located at the top of the screen.
IV. We can create drawing using notepad.
V. Wallpaper is a picture displaying on the desktop background.
V1. The process of starting computer is called booting.
Short Answer Type Questions
I Write the name of any three window applications.
1. Write the name of any three Tcons.
III. Write the names of components of a Desktop.
IV. What is Desktop?
Long Answer Type Questions:
I.  What is Operating System? Explain different types of Operating Systems.
M.  What is a Taskbar? Explain the functions of its parts.
M. What do you mean by Teon? Explain any three Desktop Tcons.
1V. Explain the different options of shutting down a Computer System.
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¢ Name the Following Icons:
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43  Parts of a Paint Window
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44  Saving the Drawing

INTRODUCTION

Paint is a drawing program used for drawing objecis and shapes. We can draw colourful
picture with paint. These pictures can be saved and printed. These pictures can be copied in
another document and can also be taken to deskiop as background.

4.1 WHAT IS PAINT?

Paint is a drawing tool which helps us to create drawings. It is a vseful program for new
users and children. There are many different tools in paint used for making colourful pictures.
Drawings in paint can be either black-and-white or coloured. We can save these drawings as
bitmap files. We can print these drawings and can use these drawings for our desktop background.
We can also paste these drawings into another document. We can save our pictures of drawing in
several types, such as jpg, .gif or .bmp files.

4.2 HOW TO START THE MS-PAINT?

——
Start E —— All Programe——» Accessories —» Paint
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Click on the start button on taskbar/ super bar. Start menu will appear.
Click on All Programs, another menu will appear.

W

Click on Accessories option in this menu. Another menu will appear. This menu has a
Paint option.

4. Click on Paint option.

OR

Click on start button and type *“Paint™ in search bar. Click the Tcon form the list and
press enter key.

Paint window will appear hike picture given below.

Paint Quick Access Home & Title Home Tab Minimize

Button Toolbar View Tab Bar Ribbon Maximize/R
O] 1 v
& cu e ; NNOQOS - vose ¥ (I
Iy Cony | Fay o £RA AR GODD = grar — _ D
o et ol A o T TR - E."", ["';'
{eptrtard image Bl hapry
&

s 5, T...." ' 4{/

Cursor Selection  Image Wirk Saroll Zoom
Position Size Size Area Bar Slider

Fig. 4.1 Parts of Paint Windows

4.3 PARTS OF A PAINT WINDOW

Paint window is shown in above figure 4.1. Tt has following main parts:
4.3.1 Title Bar

4.3.2  Quick Access Toolbur

4.3.3 Menu Bar

4.3.4  Vertical and Horizontal Scroll Bar

43.5 Status bar

43,6 Zoom in zoom out

4.3,7 Work Area
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4.3.1 Title Bar

The title bar is present at the top of the paint window. At the Iefi end of the title bar the first
item shown is little paint palette. If we click this button. a standard window menu opens, having
options Restore, Move, Size, Minimize, Maximize and Close. Another thing we will see the title
of our picture followed by the name of the program—Paint. If we haven't saved our picrare, the
name will be shown as "Untitled",

@ EdDE = IUnﬁtlad-Pm

Fig. 4.2: Title Bar

*  Quick Access Toolbar : The next four iterns alier paint paleite make up the Quick
Access Bar, offering buttons for Save, Undeo, Redo and Customize.

*  Minimize, Maximize/Restore, Close : Tiile bar has three buttons on its right corner.
They are:

. Minimize button : Used for mumimizing the paint window onto the task bar.
*  Maximize / Restore button : Used for maximizing or restoring the pamt window.

*  Close Button : used for closing the paint window.

Minimize Maximize Close

v

Fig. 4.3

4.3.2 Quick Access Toolbar

1t is a toolbar present in title bar by default. This bar provides us frequently used commands.
Its position can be changed both to below or above the ribbon and icons can be added and
removed as per the user’s requirement.

Save Undo Redo Customize Quick Access Bar

Paint Palette o el =
Fig, 4.4: Quick Aceess Toolhar

To Move Quick Access Toolbar below the Ribbon : If we prefer to show Save, Undo and
Redo buttons below the ribbon, Click on “customize Quick access bar" button and a menu will
appear.
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Customize Quitk Access Toolbar
Haw

Qpen
v save
. Print
Prink preview
Send in e-mail
Undo
Redo

<<

Show below the Ribbon

Mipimize the Ribbon

Near the bottom of the menu that appears, we will see Show below the Ribbon. Click
Show helow the Ribhon, The Quick Access Toolbar will move below the Ribbon.

Fig. 4.5: Moving Quick Aceess Toolbar below the Ribhon

*  We can add more options such as New, Open, and Print Preview eic. 1o the Quick Access
Toolbar with the help of Customize icon.

= wrueZ7
Customize Quick Access Toolbar
Mew
Qpen
V| Save
Print
Print preview
Send in e-mail
v Undo
¥ | Redo
Show below the Ribbon

Minimize the Ribbon

Fig. 4.6: CustomizeQuick Access Toalbar
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Here are commands and their functions discussed below:

New Creates a new, blank image file. Cul+N
Open ‘Opens a dialog box to open an existing image file. Cul+ 0
Save Saves changes (o the current file. Cul+S
Print Print the current picture. Cul+P

Print Preview Displays the image on screen as it will appear after printing
0N paper.
Send in e mail Send a copy of the picture in an email as an attachment,

Undo Repeat or Reverse the last action. Cul+Z

Redo Restores previous undo action, Cul +Y

Show below/ Shows Quick Access Toolbar below or above the nbbon.
above the ribbon

Minimize the Toggle the ribbon On/Off.
ribbon

Adding Ribbon items to the Quick Access Toelbar : Many other items from the ribbon
can also be added 1o the Quick Access Toolbar. On the Ribbon, right click on anything we like 10
add. A menu will appear which includes the option “Add to Quick Access Toolbar”. Click on this
option,

9 ¢ [) ¥ [Q | Transparent selection -

Pig. 4.7: Adding Ribbon items to the Quick Aceess Toolbar

Here the Magnifier, Pencil, Color2 (background colour) and Transparent selection tools
have been added o Quick Access Toolbar. To remove these items we have udded from the Ribbon,
right click on the unwanted icon and then click the Remove from Quick Access Toolbar option.

4.3.3 Menu Bar

The Menu bar has three tubs named as Paint Button. Home tab ribbon and View tab ribbon.
On the right side of menu bar, Help button appears as shown in the figure below.

m. Home View lﬂl

Fig. 4.8: Monu Dar
Paint Button : This Bution appeared al the beginning of Menu bar. When we click on this
button and following Menu Appears.
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Fig.4.9

Save As Save changes to the new file with different file name. It every
time ask for new name. We can change Format of new file too.
such as PNG, JPEG, BMP, GIF eic.

From scanner and camera | Impont picture from scanner or camera.

Set as desktop background | Set the current picture as our desktop background.

Properties Change the properties of the picture. The Properties dialogue
will give us information about the picture .

Exit To close paint window.

Home tab Ribbon : All tools, shapes. colour palette and most of the commands are grouped
together in the ribbon except Save, Undo and Redo commands which are shown at title bar or in
the Quick Access Toolbar. Drop-down arrows below each item in the ribbon will give us other
option of the tool. Most of the tools used for drawing or other tasks are present in Home Tab
Ribbon,

Home qliw
£ Cut i Crop ' r \ OO - G Outiine -
D N Copy | 121 & OOAN = B Fn-

( - e s :

@ 2Q I OO0

Image Took Shapes
Fig. 4.10: Home b Ribhon
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There is also an option to minimize the ribbon. If we choose this, the ribbon disappears
entirely, but pops into view if you click on the Home tab.

View tab Ribbon : We can uge the View tab by clicking on it. The options such as Zoom
in, zoom out, show or hide and display are there in View tab. Zoom in or out can be used alone or
in conjunction with the Zoom Tool. We can also use status bar for Zoom in or Zoom out purpose.

R o -
: | Rulers E B
Q Q u ~ Gridlines -

Zoom Zoom Full Thumbnail
in out 9& V. Statusbar | sereen

Zoom Show of hide Display
Fig, 4.11: View tab Ribbon

4.3.4 Scroll Bar
Scroll bars are used to move the screen. These are of two types:

*  Horizontal Seroll bar : It is present at the bottom of the Paint window. It moves the
screen left and right.

*  Vertical Scroll bar: It is present at the nght side of the Paint window. It moves the
screen up and down.

4.3.5 Status Bar

The Status Bar ig present al the bottom of the Paint Window. Tt gives information and
current status of our drawing. We'll look at its features from left to nght.

o 95, 420px 1] 25 26px  'C) 768 x 480px [ Size: 18.6KB 1m§f_i}- (} 4} [

Fig. 4.12: Status Bar

¢ Cursor Position : It gives the Cursor Position, which is helpful when we want to
pogition any picture precisely.

+ 95, 420px

Fig. 4.13: Cursor Position

*  Selection Size : Tt shows the size of a selection we are making or size of an object we
are drawing.

15 25 x 26px
Fig. 4.14: Selection Size
*  Image Size : Tt shows the size of our entire picture, even if the picture is very large
and is not visible completely in the window. If we have not changed the units in the
as CowruTeEr SOIENCE



Properties dialogue box, the measurement will be displayed in pixels. We can change
the measurement to inches or centimetyes.

1] 768 = 480px

Fig. 4.15: lmage Size

*  Disk Size : Once we have saved our picture, this option will show the size or drawingon
Disk. If paint window is very small, this figure might not be shown.

& Size: 22.5KB

Fig. 4.16: Disk Size

*  Foom Slider : The Zoom Slider is convenient if we are working in a zoomed-in view
and want to zoom out. However, we cannot zoom in on a particular spot, as we can do
with the Magnifier.

0WxQ — U @

Fig. 4.17: Zoom Slider

4.3.6 Work Area

Free space of Paint window is called work area. It is used for making drawing. This area is
usually between Ribbon and status bar.

4.4 SAVING OUR DRAWING

1t is good to save our picture as soon as we begin to work. We must click on the Save bution
on the Quick Access Toolbar every few minutes, This prevents loss of work if the program
closes unexpectedly, as in a power failure.

When we click the Save for the first time, we will find a dialogue box where we have to
type a nae for the picture. Type a desired nane in the file name text box and click the Save
button,

Save as:

With the help of Save as option we can Save a Copy of picture with another file name. Go

to the Paint button and open the menu.

Flg. 4.18: Faint button

Click Save as E Save as

In the dialogue box, just change existing name then click the Save bution.
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Quick Access Toolbar is present in tiile bar by default.

‘New Command creates a new, blank image file

The first on the left of the Meno Bar is the Paint Button
Maximize, Minimize and cloge button are parts of title bare.
The Status Bar is present at the very bottom of the Paint Window.

XERCISE )

7

Multiple Choice Questians :

3 4

<2HEET

The bar 15 present at the top of the paint window.
a)  Title Bar b)  Status Bar
¢} Scroll Bar d)  Task Bar

toolbar is present in title bar by default. Tts position can be changed either
to below or above the ribbon.

a)  Quick access bar b)  Staws Bar
¢)  Scroll Bar d)  All of these
The first on the left of the Menu Bar is the Button.
a)  Puaint b)  Help
¢)  Close d) Minimize
Secroll Bar 1s used 1o move the screen. Tt is of types
a) 2 by 3
c) 4 d 35
With the help of option we can Save 4 Copy of picture with another
file name.
a)  Save as b)  Open
¢)  New d)  Exit
Write the Shorteut Keys for following:
To create a NEW file
To OPEN an existing file
To SAVE a file
To PRINT a file
UNDO
REDO or REPEAT

VL
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3. Shoert Answer type Questions:

What is paint?

How to start the MS Paint.

Write the names of parts of windows of paint.
What is work area?

Explain the vse of Save command,

‘What are the types of seroll bars?

sS<<dBRT

4. Long Answer type Questions
I.  What s Quick Access Toolbar? Explain ils parts.
TI.. Explain Home Tab Ribbon.

. Let's revise whai we have studied. Write the name of Parts of Microsoft Paint Window.,
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OBJECTIVES OF THIS CHAPTER

51 Home Tab Ribbon
5.1.1 Clipboard
5.1.2 Image
5.1.3  Tools
5.1.4 Brushes
5.1.5 Shapes
51.6 Size
5.1.7 Colors

5.2 View Tab Ribbon
52,1 Zoom
522 Show or Hide
523 Display

5.1 HOME TAB RIBBON

Home Tab Ribbon of MS Paint contains the most useable tools. This Ribbon appears
below the menu bar of MS Paint. The lollowing figure shows the Ribbon and main purts of
Home Tab Ribbon,

..... N — )
Clipboard Image Tools rushes Shapes Size Colors
- - ¥ |_ - - - -

Fig. 5.1 Home Tnb Ribbon
5.1.1 The Clipboard Menu

The clipboard menu has three options—Cut, Copy and Paste. Cut and Copy icons are
shown only when a selection is active. This menu can be shown as under:
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= 4
Paste 2 D rixé, [] Ppaste

b Paste
Paste
Clipbioard - Ei e

Fig: 5.2: The Clipboard Menu
Paste 18 always active, because we may wish to Paste fram a picture on owr computer. For
example if previously, we have drawn and saved a small flower and wish to add it to our new
drawing, We can click the down arrow under Paste. click Paste from and select your saved
picture. Click Open to bring the existing picture in your current drawing.

5.1.2 The Image Menu

Select Option : Depending on the size of our window, the Image Menu will look like one
of figures shown below. When we click the down arrow just below the dotted rectangle or just
below the word Tmage, a menu offers us further choices.

1 e

e i
Swbaction Wapes
i1 Bectanguiar selection
nome [ Free-form selection
= la==" 17 | Selection options
ot A [E] setect gn
.Hn:gt | SEE:m - ?.; e
Image it e

Fipg. 5.3: The Image Menu—Select

Before we can use the buttons on the right of this menu, we must select the part of our
drawing that we want to work with.

«  Transparent selection : At the bottom of the Select menu, we can see Transparent
selection. This option is useful enough as it removes the white background of selection.
We can use our selection with only drawing objects. This option is most frequently
used, We can add this option to Quick Access bar for its fast access. There will be a
checkbox in front of the Transparent selection, as shown in figure below.

/ Transparent selection
Fig. 5.4: Transparent selection
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While that box has a tick in it, selections will be transparent. To make our selections
opaque, just click the checkbox to remove the tick.

Rectangular selection : Usually we can make a rectangular selection. After elicking
the rectangular selection tool, position the cursor at the top left of the part we want to
select, press your mouse button and drag down to its bottom night. A dashed rectangle

will appear around our selection. With the move cursor oﬁo we can move our selection
or drag while holding the Cir] key to make a copy of it

Freeform selection : We may need to make a freeform selection if the part of our
drawing that we want to work with is crowded up closely with parts we don't want 1o
include.

Copying a selection : There is a Copy bution on the ribbon for copying, but we can make
multiple copies of a selection in a faster way also. For this purpose draw a selection around the
part we want to copy, using either the rectangular or the freeform selection tool. Whenever Move

Cuorsor ﬂﬁb appears. Hold the Cirl key and drag your selection to its new location. A new copy

of the gelection will be moved to the new location. If we want to continue copying, press the Cirl
kev again as we begin to drug the second time. Repeal as many times as we needed.

Painting with & selection : Select a small piece from a picture, for example, with more
than one color, Hold down the Shift key while dragging it around to make an abstract pattern. We
can even wrile with a small selection,

Selection option ; To the right of the selection icon we can see three options, Crop, Resize
and Rotate flip.

44

Crop : Diamond shape with a line atthe top is a crop button. It helps us o crop our
picture to the selected area only. IT we click the Save icon after cropping to a selection,
our large drawing page will be replaced with the new selection area.

Saving a selected area as a drawing:

I, Save the picture we are working on.

2. Select the part we want to save as a drawing .
Click the Crop button,

4. Go to the Paint button m and open the menu.

5. Click Save as E Save 31 .

6.  Type a name for the new Selected drawing and click Save. We will return to the
Paint window with the only selected drawing and the name on the Title bar is the
name we used when saving the new Selection,

Resize and Skew : The second small bution to the right of the large Select button will
open the Resize and Skew dialogue as shown in figure below.
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,’ f q lﬂ.lsh&i Shape

Irnage Tools
] T !] A7 || Transparent selection =
Resize and skew (Ctil+W)

Resize and skew the picture or
selection.

Fig. 5.5: Reslze and Skew
*  Resize : We can quickly resize a selection by dragging any of the little blocks—or
handles—on the selection rectangle, However, if we want the size adjustment to be
precise, we musi use the Resize and Skew dialogue box. When we click the Resize
icon, the dialog box appears as shown in figure below.

By @ Percentage Piels
= -

| Horonmk 1o
jl Verticak 100
[¥] Manitain sapect sstio
Skeew [Degrees)

) IR
[ ok || Comcet
Fig. 5.6: Rosin

Only the wop half of this dialogue is concerned with resizing,.

Note : While the option Maintain aspect ratio is checked, whatever we type into the
Horizontal slot will be repeated in Vertical and our selection will stay exactly in
proportion. We can remove the check if we want the selection to be fatter or thinner.

Be===xB====p
M o - By
Fig. 5.7
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Skew : The bottom part of the Resize and Skew dialogue box allow us to skew our
selection. When we use this option, it makes our selection include a lot of border area
1o avoid having part of the picture cut off. If this does happen, click Undo %) and
make a wider selection before irying again.

.

Fig. 5.8: Skew
This bhie box is skewed 20 degrees horizontally. We can skew a selection both
horizontally and vertically,
Rotate or Flip : This menu helps us in rotating our drawing item to 90 degreesor 180
degrees. We can also make mirror images of selections using this option. We can
mirror the drawing either vertically or horizontally.

“A Rotate right 90*
~  Rotate left 90"
Rotate 180"
Flip vertical

Flip horizontal

Fig. 5.9: Rotsie or Mip

We cun use this option for making some systematic designs i Mon
in MS Paint,

3 Sopy
Invert Color : Another set of options are available if we | ) o4
right click on a selection. It includes Cut, Copy, Paste, | Cop
Crop, Select all, Invert selection, Delete, Rotate and il setecean

Resize, the only one option that is available on this menu £+ | pwertserection
and nowhere else is Invert color. This option make the x

. : ’ Delets
light colours darken and vice-versa (o create invert colour “A| Rotate »
]
s ‘A Re
& Regize
o Irwvert color

Fig. 5.10: Invert Color
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5.1.3 The Tools Menu
Tool Menu of the MS Paint contains some basic tools for drawing.

/& A
& 2Q
Tools

Fig. 5.11: Tvols Menu
*  Pencil : The pencil tool is used for free-hand drawing. We can work with pixel editing
when using this tool in zoom-in view.

7

Fig. 5.12: Pencil

When we work with the pencil tool, we must press the left mouse button to draw with
Color 1 and with the right mouse button to draw with Color 2,

Note : Color 1 in Paint is referred to as the Foreground color and Color 2 is the
Background color of the picture. We can also change the pencil's thickness in the Size
tabto 1, 2, 3 or 4 pixels.

*  Fill with Color : The Fill with color tool, is used to fill an area with a single color.
Color | is used if we press the left mouse button on the area to be filled. Color 2 is
used if we press with the right mouse button.

>
Fig, 5.13: Fill with Color

This tool does not work successfully if we are trying to color different shades of one
color, The Fill with Color tool always fills with a solid color,

*  The Text Tool : Like carlier versions of Paint, The Text tool is used to insert any text.

A

Fig. 3.14: Text Toul

To begin inserting text, click on the text tool. Our cursor will change to an insertion
bar. With this cursor we can draw required size of area for texts. We must not click
anywhere outside that area until our text is final from all aspects. When we are using
Text Tool then Text Toolbar start appearing.
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Wiew 'J Teut

Lucida Console -

2 -|B J U aba
Fant Background
Fig. 5.15: Text Toolbar
Formatling the Texi:
. Select the text we have typed.
2. Click the down arrow at the end of the Font Name box, on Text toolbar so that a
list of fonts drops down.
3. Run your cursor—withourt pressing any mouse buttons—up and down in the font list.

As we do this; the appearance of the text we have typed will change accordingly.
When we like what we see, click on the name of that font.

4. After clicking on the font, font list will close.

5. We can repeat this process with the Font Size list also.

6. We can also click the Background from Transparent to Opaque or vice versa.
7. We can change both Color 1 and Color 2.

Note ; If we hit the enter key at the end of our text, the box will expand downwards. We can
also use the handles to move the text box across the page, pulling it wider on one side and
pulling it in on the other. There is no way to align our text automatically to the centre, we can put
our cursor to the left of the text and press the space bar as many times as necessary to center align

the text. a'z ﬁg W
Have a nice day!!

Fig. 5.16: Formatting the text

We can also type text in different colors, fonts and size, in the same text box. When we are
muaking changes, only selected text will be affected. When we have completed editng of texy, we
can click anywhere oulside of your text box. After clicking away from the text box, the Text
Toolbar disappears and the text becomes part of our picture. Now, it cannot be edited in any way.
*  The Eraser : The Eraser tool erases the pant of a picture with the left button of
the mouse pressed, It changes whatever is dragged across 1o the background color—

Color 2 P—

P4

Fig. 5.17: Eruser
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With the right button pressed, the eraser tool changes pixels of Color 1 to Color 2. but
leaves everything else unaffected.

*  The Color Picker : The Color Picker Toolisused tosetthe current | g
foreground or background color and to match any color in our picture. ,
Tt's especially useful when colors in the picture are different from
those on the paleite. By picking a color from the picture, we can
make sure that we are using the same colour as already used inthe T8 51%
drawing, ST "
For example we are zoomed in and working with the Pencil tool on an area that has
many shades of red and we want to use one of those shades. Click the Color Picker
and click directly on the shade of red that we want to use. The tool will immediately
change back to the Pencil, loaded with the color we want, e ——

*  The Magnifier : The Magnifier Tool is used to zoom inon a section f
of our picture. Magnifier can be clicked over an area of which we
want a closer view, The Left click gives a closer view and Right

lick zoom out, Fig 5.1%;

Mugnlfer
5.1.4 Brushes

We can work in various widths and texiures with the help of Brushes. Widths are controlled
by the brushes and the Size Tool together; textures are controlled by the brushes,

Vig. 5.20: Brushes

In the figure shown below lines are drawn with each of the offered brushes, using the same
color and the sarne line width [or each.

brush — —
calligraphy 1 s —

] calli[r&ph‘r} e

Pty airbrush -

SRR coon RS

natural pencil
I water color R
Fig. 5.21: limes are drawn with Brushes
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5.1.5 Shapes

In the Shapes Gallery several tools like Rectangles, Rounded Rectangles Ellipses and
Freehand Polygons, the Line Tool and the Curved Line Tool can be seen. There are number of
other shapes such as arrows, speech balloons. various stars and others are also included.

@ [F Outline ~
K2 Fill »
‘ Shapes
Shapes
Fig. 3.22: Shapes
We can open the Shapes Gallery by clicking the down arrow under the Shapes picture and
click the shape we want o draw.

\VOEDA&A

NOQOQOD At
Sh g gsiminie

VA

Fig. 5.23: Shapes Gallery
*  Straight Lines : Straight lines can be drawn while the left mouse button is pressed and
will uge Color 1, those drawn with the right button will use Color 2, Line will be
perfectly straight, If we hold down the Shift key while drawing a line.

*  Curved Lines : Click the ./ Curved Line button to draw a curve. Click the Outline
button and choose Solid Color or a texture of your choice. Then click under the Size
picture and choose 4 line thickness. Now, we can draw the curves.

Fig. 5.24: Corved Lines

*  Ellipses, Rectangles, Circles and Squares : If we want to draw an exact shape such
as a square or a circle, hold the Shift key while we draw.
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*  Frechand Polygons : To draw a freehand polygon. click the Polygon button & in
the gallery. Hold a mouse button down and draw the first line of the polvgon. Then
release your mouse button and click where you want the next line to end. Keep clicking
end points until you want the last line to finish the shape, then double click

start

Fig. 5.25: Frechand Polygons

5.1.6 The Size Tool
This tool becomes aciive only after we choose either a Brush or a Shape. Afier selecting our
Brush or Shape we will [ind dovwn arrow under Size Toel and can choose a line thickness. The

line thicknesses offered varies according 1o the brush we have chosen,

| —=—]
Size

Filg. 5.26: Stee Toal

5.1.7 Colors

The Color section of the ribbon has three parts: 1. Colour Boxes (Colour-1 or Colour-2)
2. The colour palette, 3. The Edit colour button
1.  The Color Boxes:

| |
Color | Color Cnln Color
1 2 1 2

Fig, 5.28 Calor 2 selectes] in Colar Buxes

Fig. 5.27 Color 1 gelected in Color Roxes
. Color 1 is the Foreground Color and 1s always black when we open Paint.
*  Color 2 is the Background Color and is always white when we open Paint.
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The Color Palette : The two top lines of the Color Palette show all the colors available

whenever we are making a picture. The line of blank squares at the bottom shows
those colors, we have edited during our work. Once Paimt is closed, the edited colors

vanish away.

EEEEN
H["[J.

L
=

HI.I
|

.L

."-. r."1
e —
=\

1 ]

of

Fig. 5.2%: Color Palette

Edit
colors

Fig. 5.30: Edit Colors

The Edit Colors dialogue box is shown in figure below:

Edit Colors : The Edit Colors button takes us into the Edit Colors dialogue box.

Basic color
ErEErEEn
ErfrEErNFEER
EENEEEERE
EiEEEEEN
EEEEEEEN
EEEEERTER
Custom color
| T s i - -

Hue 163 e 200
T | 1 | B s % Guen
| Deshiran Cumizen Cislion ColoriGold Lum: 159 B 270
ok ][ Coal | [ Ak 2 Custom Colera

Fig. 5.31: Fdilt Colors

Here we can click any color on an extended palette and click the Add o Custom Colors
button. Here only one color at a time will be added to the squares under the color palette. To
add more we must return 1o the dialogue box and add them one by one each time.

5.2 VIEW TAB RIBBON

The following section explains the View Tab Ribbon. Tt has three main options: Zoom,

Show or hide and Display.
52
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5.1.1 Zoom

Zooming in and out can be used alone or in conjunction with the Zoom Tool on the Ribbon
or the slider on the Status Bar. Zoom in and Zoom out tools can be clicked repeatedly to geta
closer or more distant view. The 100% option brings ug back to normal view of the picture.

5.1.2 Show or Hide

This portion of the View Tab Ribbon includes:

*  The Show or Hide option for the status bar. The status bar is very useful while
drawing pictures precisely.

*  Gridlines are convenient if we want to align shapes accurately.

*  Rulers can be turned on or off as per our requirement.

5.1.3 Display

On the Display section, we can click for Full Screen View. We can also get a Full Screen
View by hitting F11. We can come back 1o a normal view by pressing the Esc key.
*  Thumbnail is active only when we are Zzoomed in. It helps us seeing how changes, we
have made are affecting our picture in normal view.

.  Many of the tools we use in Paint are found in the Home Tab Ribbon

2. The clipboard menu has three options—Cut, Copy and Pasie.

3. The top button. a diamond shape with a line through it. 1s crop. It helps us to crop to
our picture so that only the selected area remains.

4. The Eraser wol erases the part of a picture with the left button of the mouse pressed.

5. Zooming in and out can be used alone or in conjunction with the Zoom Teol on the
Ribbon or the slider on the Status Bar.

] ExEResE)

1. Multiple Choice Questions :
I, The clipboard menu has three options—Cut, Copy and

a) Paste b) Move
¢) Close d) Zoom
[I. The top button, a diamond shape with a line through it is
a) Paste b) Cut
¢} Copy d) Crop
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. The tool can be used to draw pentagon.

a) Triangle b} Rectangle
¢)  Pentagon d) Hexagon
IV. The Eraser tool erase the part of a picture with the button of the mouse
pressed
a) Left b) Right
¢} Scroll d) None of these
V. Color 2 is used if we press with the mouse button
a) Left b) Right
¢) Scroll d) None of these

!\!

Very Short answer type Question —Answer in one word:
Which tool is used to draw a Square?

Which tool can be used to erase a part of picture?
Which tool allows us for zoom-in our picture?

Which tool is used for free-hand writing?

Which tool can be used to write text in our drawing?

~ 2 BgHR¥

3.  Short Answer type Questions:
‘What are the options available in the Clipboard Menu?
Write about Crop option.

. Write the name of tools available in Tools Menu.

. What ig size tool?
Write about brushes tools.

S FEEREPT

. Give the name of groups present there in home tab ribbon.
4.  Long Answer type Questions:

1. Explain the color tools of MS Paint.

II.  What is Text Tool? How to Formal the text.

I.:-'lh { !I 1; ii [_II".

Name the following tools:
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Name the following Shapes:

A

O

Drraw the following Drawings in paint:

=
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HARDWARE AND

_ HAPTER - 6

OBJECTIVES OF THIS CHAPTER
61 What is Hardware”

6.2 What is Software?

6.3  Types of Software

6.4  System Software and Application Software.
6.5  Relationship between Hardware & Software

INTRODUCTION

Keybourd, Monitor, Speaker, CPU, and Printer are the components of Computer. All these
are called Computer Hardware. All the instructions given in the form of Computer Program are
called Software. Soltware programs are stored on storage devices hike hard disk. Let us learn
about them in detail.

6.1 WHAT IS HARDWARE?

In the Computer World Hardware reters to the physical components like keyboard, Mouse,
Printer, Monitor that make up computer sysiem. Input is feed and output is received through
hardware software and data 1s stored on Hardware devices such as hard drive, Hardware can be
louched und sensed.

6.1.1 Features of Hardware

We can touch and feel hardware. It occupies space and are having their weight. Hardwares

are having their physical existence oo. Hardware of computer system can be ag under:

System Unit (CPU)
Flat Panel Display 4
,

\

Speaker
~

-rh -
Key-board

Fig, 6.1 Deshtop Computer System
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Svstem Unit (CPU) : The System Unit also known as CPU of a computer system contains
essential components such as mother board, processor, RAM, Hard Disk. CD ROM eic. All
these parts are kept in a plastic or metal box known as Cabinel or computer case.

Power Bution Main Power
ChIDVD Power Button
Audio Port
HDMI Display
LJSB Port
o VGA Display
USE Ports
Metwork Port (LAN)
Sound Card Ports
Front of System Unit Back of System Unit

Fig 6.2 System Unil Views

Motherboard : The motherboard 15 2 PCB (Pnnted Circuit Bowrd) which is used o
connect all the internal parts of computer. We can see a motherboard in the diagram shown
below:

Fig 6.2 Mother Board

Some of the components that are connected with motherboard are:

*  Hard Drive : Hard drive Or Hard Disk is the main storage media device that
permancntly stores all data on the computer.

*  Video Card : The video card is a device in a computer that outputs visual information
to the monitor,
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Processor @ Processor carries out the instructions of a computer program by performing
the basic arithmetical, logical, control operations of the system.

FAN : Every computer has a cooling fan designed primarily to prevent the CPU from
overheating.

RAM : Ram is known as Random Access Memory. This is a Main Memory of
Computer which is considered as Primary memory. All the data and instructions are
loaded in Lhig primary area of computer before processing, This memory 18 volatile
and all information that was stored in this memory is lost when the computer is tarned

off,

Power Supply : The component that supplies power to a computer.
CD/DVD : A disc that store large amounts of data

6.1.2 Important points for taking care of Hardware

If different components of computer are not properly looked after, they get spoiled very
goon, Following points should be kept in mind while handling Hardware:

7

II.

Keep all the parts of compuler clean,
Cowver it after use.

III. Do not pull cables of computer Parts.
1V.  Press keyboard keys gently.

V.

Do not cat in the Computer Room.

VI. Keep Hardware in proper manner.

VII. Keep your shoeg outside the computer Lab,

VIII, Handle different parts of computer in a proper way.

IX. Use soft cloth or brush to clean computer,

X.

Do not clean the equipment while the computer is turned on.

6.2 WHAT IS SOFTWARE?

A Computer without instructions is like a car without dnver. Computer requires a set of
instructions given by us to work on input data. Sequence of instructions is called program.

Software is the collection of program that are stored and run on computer. Software is a
program stored in a storage device. We can design our own software or we can get ready made
software from market. e.g. CDs of games. Software helps the computer to perform a particular

operation,

Features : Software has no weight. We cannot touch it. A software makes a hardware
working. e.g. MS Word, Games etc.

Instruction + Instruction = Program
Program + Program = Softwure
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Instruction - 1 }— Program -1 |—
Instruction - 2 — Program -2 |
>  Program —>  Software
Instruction - 3 — Program -3 |—
Instruction - | Program - |
Fig 6.4

6.3 TYPES OF SOFTWARE
Softwares are of two types:-

¢ System software

* Application Software
6.3.1 System Software

System Software is defined as a collection of programs that controls the overall operation
and internal working of the computer system. It reuds data from mnput devices and trunsfers the
processed information to output devices. Tt works like a manager. Tt is an important part of
computer. A Computer can never be used without System Softwares, e.g. Operating Svstem,
Utility Program, Language Translator. These are costly, It difficult to design system sofiware.
System Softwares are developed by experts only.

“Windowszo03 Windows

REEES -

Figure 6.5
6.3.2 Application Software
These type of soltware are used for some particular operations. There are several types of
Application softwares available now a days, Each one of them are having their own application
arcas. These type of softwares can be used for beautifying the documents, making calculations.
arranging data in an organized way, System software is the nced of every computer but application
software can be different for different computers. It 15 an non-essential part of computer hence it
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depends upon the need of the user. These are also called general purpose software. e.g. Spread
Sheet Software, Word Processor, Graphic Sofrware.

6.4 SYSTEM SOFTWARE AND APPLICATION SOFTWARE

System software is different from Application Software 1n many aspects. Let us differentiate
the two;-

L. Itis an essennal part It is non-essential part
2. Ttis very complex It is generally simple
3. Itis expensive Tt is cheaper
4. It can be made by expert only A person with less experience can made it.
5. Computer cannot work without it. | Computer can work without 1t
Eg. Operating System Eg. Paint, Word, Excel, PowerPoint, Games etc.

6.5 RELATIONSHIP BETWEEN HARDWARE AND SOFTWARE

For a Computer to produce useful output its Hardware and Software must work together.
Nathing useful can be done with the Hardware on its own and Software cannot be utilized
without supporting Hardware. Huardware components are controlled by software. To take an
analogy. a cassette player and its cassettes purchased from the market are hardware. However,
the songs recorded on the casseties are its software. To listen a song, that song has to be recorded
on one of the cassettes first, which is then mounted on the cassette player and pluyed.

T + . - o

|, Parts of computer are called Hardware.
2. Hardware has weight. It can be touched and sensed.

60 CoaruUTER SCIENCE



Group programs are ¢alled Software.

We cannot wouch software.

he T B B g i

To use hardware properly, we should keep it clean.

Printer, Monitor, Keyboard, Mouse, Hard Disk are parts of Hardware.
Software is of two types:- System and Application Software.

MLS. Word, Excel, Paint are examples of Application Software.

(exenche)

1.  Multiple Choice Questions:

1. Computer is a combination of hardware and

(a) Soltware (b) Application
(¢) Processor (d) All of these
2, Set of ingtructions is called
(a) Software (b) Hardware
{c) Program (d) Application
3. Group of programs is called i
{a) Hardware (b} Software
(c) Processor (d) None of these
4.  Software is of types.
(@) 2 (b) 3
() 4 (dy 5
5. Computer cannot work without
(a) Word (b) Excel
(¢) Operating Sysiem (d) PowerPoint
1, Fill in the Blanks :
I. 'We cannot touch ..o 2
1I. Physical parts of a computer are called ................... .
| 11 S e is also known as Random Access Memory.
IV software are used for some particular operations.

3. Very short answer type questions

. Which part of CPU connects the other parts like Processor, Hard Disk, Ram etc

IT. What we call a set of instructions given 10 a computer?
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III. Which part of computer cannot be touched but fele?
IV. What are two types of Software?

V. Which type of softwares are expensive?

Short answer type questions

What is Hardware?

What is Software?

. Give four examples of Hardware.
‘What are the qualities or features of Sofiware?

<<zg 8~

. Explain the important points for taking care of hardware.

[L.ong answer type questions

. White the name of devices which are connected with motherboard?

1. Write the difference between Application Software and System Software?

. Write a note on Hardware.

‘J RELIP AC

Put the following terms into their relevant type:

Floppy disk Hard Disk

MS Word CD

MS Paint Mouse

Monitor MS Excel

Keyboard Operating System
Software [ Hardware
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Take the students to computer lab in a group make a list of hardware and software
parts present in the Iab. Put a tick before the parts which are present in your lab
given in a list below:

1. Key-board

2. Mouse

3. Monitor

4, Printer

5. Speaker

6. CPU

7. Windows

8. MS Paint

9. MS Word

10, Internet

11, UPS

12, Scanner

13. Joy Stick

14, Camera

15, Microphone

- 'l““:"-.g.l




"CHAPTER -7 INPUT DEVICE

OBJECTIVES OF THIS CHAPTER

7.1 Input devices
7.2 Uses of Input Devices

73  Keyboard

74  Mouse

7.5  Microphone

7.6  Scanner

7.7  Web Camera

7.8 Touch Pad

7.9  Bar Code Reader
7.10 Light Pen

7.1 Joy Stick

7.12 Touch Screen

7.13 Biometric

7.14  Electronic Signature Pad

INTRODUCTION

CPU alone can do nothing in a computer System. It has many helping devices. These
devices are having their particular nature of operation to perform. Devices which accept input
within computer are called Input devices. In this lesson, we will study about these devices in
detail.

7.1 INPUT DEVICE

An input device is any hardware device that reads data into a computer System. It allow
users to interact with computer and control it. Devices that accept data and Instructions from
user are called Input devices, Input devices are necded to give input to the computer.

7.2 USES OF INPUT DEVICES

It CPU is the brain of computer then the Input devices of computer such as key board,
mouse and microphone are its eyes, ears etc, Without input devices, a computer has a brain with
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nothing to work with. We use input devices to give data and information to the computer.

Generally used Input devices are:

*  Keyboard *  Mouse

- Micrnphane " Scanner
*  Web Camera " Joy Suck
*  Light Pen cic.

7.3 KEYBOARD

This is main Input Device. A Keyboard is a device with set of keys that enables you to enter
text data in to a computer. A keyboard has many buttons which are called keys. A keyboard is
used for typing letters, words, numbers and special symbols. Tt is a standard inpuot device. Number

of Keys on a keyboard can be vary among different types of keyboards .

*  Alphabetical Keys
*  Numeric Keys

*  Funetion Keys

*  Special Keys

*  Arrow Keys

¢  Special Symbols Keys

Figure 7.1 Keybiourd
Types of Keys : Keyboard has following types of Keys. These are

COIL 0]
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Alphabetical Keys (A to Z) : Alphabet keys are used to type characters. These keys
are present in the middle of the keyboard. All the keys A to Z are called alphabet keys.

Nomerie Keys (0 to 9) : The numeric keys are nsed to type numbers, These keys are
present below the functional keys. On the right side of keyboard a special pad is present.
Tt containg 17 keys. This key pad is called numenic key pad.Thiz pad is similar to
calculator, because along with aumbers it also has mathematical signs and enter key.
On the left top of the pad, a key named num lock is also provided. The Key's of this
key pad works if num lock is on. The status indicated by the indicator om the keyboard.

Function keys (F1toF12) : These are 12 keys. These are from F1 to F12. These are
located at the top of the keyboard. The function of these keys can be different for
different program. Eg. Fl key is generally used for help.

Figure 7.3 Fonction Keys

Special Keys : Each special key is used to perform a special function. Some special
key with their functions are mentioned as under:

1 Delete To delete characters written on right side of cursor

2 Back Space To erase character present on left side of cursor

3 Enter To start & new line or (o execute the command

4 Spacebar To insert spuce between two words or texts

5 Shift It is used along with other key e.g. when shift and 'a’ pressed
together it will print A

6 Control It is also used along with other key e.g. in paint Curl and S key
when pressed together, they save a file

7 Alt Key Ttis also used with another key e.g.- alt + F4 are pressed together
to close an open program

8 Caps Lock When we press caps lock key then an indicator appears on the
key board. It means caps lock is on, it means capital letters will
be written

Arrow Keys @ These are used to move cursor. These are four in number. These can
move up, down, left, right, Arrow Keys are used to

move the cursor in all directions, D
Special Symbol Keys : These are special symbols

used in typing to represent some special meaning. - I m
These symbaols are used to represent pause in sentence,

full stop, arithmetic operations elc. Fig 7.4 Arvow Keys of Key Board
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7.4 MOUSE

Mouse is an important Input device. It is used to control
cursor movements on the sereen. It 15 a small hand holding
device. Ttis also called pointing device. Generally it has three
buttons. It is called mouse because of its shape. Mouse is rolled
over a [lat surface. As you move a mouse, the cursor also moves
on the screen in same direction. Figure 7.5 Mouse and Mouse Pad

Mouse pad : The pad on which we move the mouse 15 known as the Mouse pad. Mouse
has following three buttons:

. Left Button
*  Right Button
. Seroll Button

*  Left Button : Generally left button is used for selecting an item or running & program.
When left button on mouse is pressed then it is called "click” operation, When This
button is pressed twice, it is called "Double Click". The programs are opened with
double click, While things are selected with single click.

*  Right Button : When we press right button, it is called right click. It is used to open
shorteut Menu.

*  Scroll Button : Tt is just like a wheel fixed in the centre of left and right button of
mouse. It rotates the screen which is called scrolling. It is used o move screen up and
down,

7.5 MICROPHONE

It is also called Mic and is used for sound input. We can give
voice instructions to computer with the help of mic of your computer.
If & computer has microphone then you can record your own voice.
we can listen recorded voice with output device. Those users, who
cannot type can give input to the computer with microphone. Using
microphone we can also talk to our [riends on the Internet.

Figure 7.6 Micraphone

7.6 SCANNER

Scanner i an input device. It is used to add text and picture in computer. Tt works like a
Photostat Machine. Scanner scans a picture or document and gives it 1o the computer in the
form of digital signal, Scanners are available in many types and shapes in the market.

Filgure 7.7 Scunner
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7.7 WEB CAMERA

Web Camera is used w click photographs. It works similar to digital camera, but web
camera saves photos in computer. Web camera is nol an expensive device. We can use (s
device for video conferencing.

Figure 7.8 Web Camera

7.8 TOUCH PAD

Touch pads are used in laptop in the form of a small panel contaming different touch-
sensitive areas. It is used in place of mouse. The buttons of touch pad are similar to mouse i.e
lefi right buiton which are at the bottom of touch pad. A wouchpad is operated by finger and
dragging it across a flat surface. As we move our finger on the surface, the cursor on screen will
move in that same direction.

Figure 7.9 Touch Pad

7.9 BAR CODE READER

A Barcode reader (or Barcode scanner) is an electronic
device for reading printed barcodes, Like a flatbed scanner, it
consists of a light source, a lens and a light sensor translating
optical impulses into electrical ones. It is used in shops, stores
for differcnt reasons, These are helpful in stores in order 0
maintain accurate and updated inventory monitoring. They can
help to determine the price of an item. Itis a fixed input gadget
that is used to capture and read informauon enclosed in a bar
eode, This deviee consists of scanner.

Figlll'v 7.10 Bar Code Reader
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7.10 LIGHT PEN

It iz a pointing device. It is just like a pen connected to a VDU. The tip of light pen
contains a light sensitive element which when placed againgt the screen, detects the light from
the screen enabling the computer to identify the location of the pen on the screen. Light pen has
the advantage of drawing directly on to the screen.

Figure 7.11 Light Pen
7.11 JOY STICK

Joysticks consists of a base and a stick that can be moved in any direction. The stick can be
moved slowly or guickly as required. Some joysticks have sticks that can also be rotated to the
left or right, Because of the flexible movements of joystick, it can provide much greater control
than the keys on a keyboard. It is often used to control video games and usually have one or more
push buttomns.

Figwre 7.12 Juy Stick
7.12 TOUCH SCREEN
This i8 a type of display screen that has a wouch-sensitive rransparent panel covering the

screen. Instead of using a pointing device such as a mouse or light pen, you can use your finger
to point directly to objects on the screen. For example ATM machine, Smart Phones etc.

Fig 7.13 Touch Screen
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7.13 BIOMETRIC

Biometric verilication is any means by which a person can be uniquely identified by iis
body parts like ingerprints, hand, eye, etc. These devices are having very sensilive scanmers
placed in them. To use it, place the finger on this device, the scanner scans the pattern of finger-
prints and send the signal to digital circuit for verification purpose. Authentication of the same
allows the requested operation. On failure of venification, an error message of the same i3
displayed.

Fig 7.14 Biowmetric

7.14 ELECTRONIC SIGNATURE PAD

It 18 an electronic device used to capture written signatures and convert them to digital
format. This device is having on hand holding pen and a digitally sensitive pad. When the pen is
moved on the pad, iis movements are being identified and given to computer in the form of
digital signal to make the respective input.

1. Input devices are used o give input to computer.
Keyboard is an input device. It looks like a type writer.
Mouse is uged 1 move cursor here and there.

Scanner 18 used 1o add text und pictures in the computer.
Web Camera sends photo graphics in the computer.

Mike is used to record Voice in the computer.

B - ol

Touch pad is used in laptop.
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10.

()

Bar Code Reader is used in Big Stores.
Light Pen is a pointing device.
Joy Stick is used to play video games.

Multiple Cheice Questions :

L is used o click photos in computer.

a)  Headphone b)  Webcamera

¢)  Speakers d) None of these
II. Bar Code Reader Consist of

i)  Sensor b) Light

¢) Heat d) Magnetc
1. is a pointing device.

a) Headphone b)  Keyboard

¢) Mouse d) Web Camera
V. 15 used to add text and Picture in computer

a)  Printer b)  Scanner

c)  Speakers d)  Mouse
V. keys are used to move cursor in all directions

a)  Mrow b)  Special

¢)  Function d) Numeric

Fill in the Blanks :

(DT — devices are used to give input to computer.
IL i is used to record voice in the computer.
E G is used to play video games.

IV, Touch pad is used i ..o, .
AR -7 — function keys on the keyboard.

Very Short Answer type Questions:

I.  Which device is used to capture pictures in computer?
I,  Give the pame of any Pointing device,

M. How many function keys are there on a keyboard?

IV. Which device is used to control video games.

V. Which keys are used to move curser.
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Short Answer type guestions:

1. Define Input Devices?

II. Write the name of any six input devices?

M. Write short Note on Joy stick?

Long Answer type Questions:

1. Explain any two input devices.

II. Write a note on Bar Code Reader?

II. Whatis Mouse? Explain the functions of Mouse Butions,
IV. What are pointing devices? Explain with Examples.

V. Explain Special Keys and their functions.

Take the students to computer lab in a group to identify the keyboard’s Keys. Let’s count
and write the no of keys of given type on your keyboard in a list below:

| Alphabet Keys

2 Special Keys

3  Function Keys

4 Numeric Keys

3 Arrow Keys

6  Total Keys
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CHAPTER - 8 OUTPUT DEVICES

OBJECTIVES OF THIS CHAPTER

8.1  Output Devices
8.2  Types of output devices

8.3  Monitor
84  Printer

85  Speaker
8.6  Headphone
8.7  Plotter

8.8  Projector

89  Difference between Input & Qutput Devices

INTRODUCTION

Computer System performs all the operations as per input given to it. The input can either
be data or Instructions, All these instructions are implemented on given data to produce required
result. This result is given to the user as an output, We use scveral types of output devices for this
purpose. In this lesson we will learn about different output devices.

8.1 OUTPUT DEVICES

An output device is any hardware device used to give the results of data processing of a
computer System. This Device converts the electronically generated information into human-
readable form. Output devices are connected 1o computer and these are used to show data in term
of sound, text and images. They are used to get result from computer. In other words these
devices get output from the computer.

Uses of output device : Output devices are used 10 get information from computer. It can
be either in soft copy or hard copy of information. Whatever the computer has done is given 1o
user by output devices.
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8.2 TYPES OF OUTPUT DEVICES
Every Output device has its own work. Commonly used Output devices are:-

*  Monitor " Printer

*  Speaker *  Headphone

* Plotter *  Projector
8.3 MONITOR

It is most commonly used output device. It is a soft output device which looks like a
television. It shows output on its screen. Here are two kinds of viewing screen used for monitors.

*  Cathode-Ray Tube (CRT)

*  Flat- Panel Display

8.3.1 Cathode-Ray Tube (CRT) Monitor

Many Types of CRT monitors are available in the market. CRT Monitor size is measured
by diagonal length of the screen, Monitors are available in 1537,177,19 and 21". Earlier black and
white momtors were used but now we use coloured momtors. Such monitors display coloured
pictures.

Figure 8.1 CRT Manitor
There are some disadvantages of CRT :
*  Large in Size
*  High power consumption
8.3.2 Flat-Panel Display Monitor

The flat-panel display refers to a class of video
devices that have reduced volume, weight and power
requirement in comparison to the CRT. You can hang
them on walls. Current uses of flat-panel displays include
caleulators, video games, monitors, laptop compuler,
graphics display, Some example of Flat-Panel Display
monitors are LCD, LED, Plasma etc.

Flgnre 8.2 Flat Panel Display Maonltor
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8.4 SPEAKER

Speaker is an output device. They receive audio input from
the computer's sound card and produce audio output in the form of
sound waves. Itis used to listen sounds produced by computer. we
can listen songs with speakers, Speakers are available in differemt
shapes. Generally there are two speakers attached with one
COTRPULET.

Figure 8.3 Speakers

8.5 HEAD PHONE

Sometimes referred to as earphones, headphones are hardware devices that either plugs
into your computer (line out) or with your speakers and allow you to privately histen to audio
without disturbing anyone else.

Figure 8.4 Headphone
8.6 PRINTER

Printer prints output on paper. It is a hard output device. The output of printer is permanent.
Its output can be preserved. Printers are available with different speed resolution and size in the
market. Black and white as well as coloured Printers are available now a days. Coloured printers
give coloured printout. Printers are of three types:

. Dot matrix Printer
* Inkjet Printer

*  TLaser Printer

8.6.1 Dot Matrix Printer

This type of printers prints by joining dots, Its printing cost is very low.Its speed is slow
and their printing output is very poor. It produces sound while working. The resolution of its
printing is very low.

Figure 8.5 Dot Malrix *rinter
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8.6.2 Inkjet Printer

This type of printer i an example of coloured printer. These printers are having less cost
and it does not produce sound while working. Tis speed is faster than dot matrix printer. The
running cost of this type of printers is very high.

Figure 8.6 Inkjet Printer

8.6.3 Laser Printer

This type of printers is both black and white as well as
coloured. These printers are very costly. Their speed is very
fast as compared o other printers. Their printing quality is
very high. They work silently and their unning cost 18 very
low. These printers are most widely used due to their less
running cost and very high printing quality.

Figure 8.7 Laser Printer

8.7 PLOTTER

Plotter is a hardcopy output device. Tt is used to print in the form of vector graphics. Tt is
used in computer aided designing. These are used for some specific areas of applications like
engineering design, Graphical Designs etc. They uze pen for drawing pictures on paper.

Frgure 5.8 Motier
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8.8 PROJECTOR

A projecior is an output device thai can produce a large display in the form of visual output
on [at (usually hightly coloured) surface. For example, projectors are used in meetings to help
ensure that all participants can view the information being presented.

Figure 8.9 Projector

There are also many devices that are used for both Input and Output. For example

1. Digital Camera

2. Pen Drive
3, CD/BVD
4. Modem
5 Fax

Optical pen Joystick

/&

Bar code reader

_
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8.9 DIFFERENCE BETWEEN INPUT AND OUTPUT DEVICES

1. These are used to give data & 1.  These are used to get resulis
instructions to CPU. from CPU.

o Keyboard, mousze, scanner, web camera | 2.  Prnters, monitor, speaker elc. are
etc. are examples of input devices examples of output devices

Output devices are used to get information from computer.

Monitor is & soft outpul device it shews text and pictures on the sereen.
Printer is hard output device, It prints output on paper.

Printers are of many types like Inkjet, Dot-matrix and Laser.

Speaker is used to listen sounds of computer,

|
2
2.
i,
-
6.

Plotter is for printing vector graphics

1.  Multiple Choice Questions :

I.  Monitor is soft and is hard output device.
a) Printer b)  Ploter
¢)  Both of these d) None of these
IL. 15 used 10 listen sound of computer.
a)  Printer b)  Speaker
¢)  Microphone d)  Mouse
L. prints output on paper.
a) Printer b)  Keyboard
¢)  Mouse d)  Speaker
V. printer prints by joining dots.
a) Dot matrix b)  Inkjet
¢) Laser d) None of these
Y.  Monitors are of Lypes
a 2 b)
c) 4 d)
V1. Headphones are also called
a)  IPhone b)  Earphone
¢)  Both of these d) None of these
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Tt

ad

1)

2)

6)

Fill in the Blanks :

| devices are used to get information form computer.
T oorcsmsrnsnmnnns i a software outpul device.

Il ....cccecoern.. 18 & hard copy output device.

1, TR —— printers print by joining dots.

V. Speed of .cincainia printers is very fast.

Short answer type guestions

I.  What are output devices?

II. What are Speakers?

III. Where is projector used?

IV. Whar are the types of printers?

V. Write a note on Printer?

V1. Write the name of any three output devices.

Long answer type gquestions

I.  Write note on monitor and its types?

11, Write the difference between Input and Output Devices.

Let’s check our knowledge in the form of an activity. Count the devices in your school and
fill in the boxes against their names. Also Tick () in the related box for each device type:

Device Count the devices in Softcopy Hardcopy
your school.

Monitor/LED

[Laser Printer

Speaker
Headphone
Inkjet Printer
Projector
s ESES T
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APPENDIX -1

COMMONLY USED SHORTCUT KEYS

(MS PAINT)

Cul + A Select entire canvas

Ctrl + C Copy selected area
Cal+ X Cur selected area

Ciul +V Paste clipboard data
Cul+2Z Undo last action

Cil+Y Redo action

Col+E Shows image propertics
Cirl+ G Toggles grid lines
Cul+P Print the picture

Cul+R Show or hide the ruler
Cul+W Open the Resize and Skew dialog box
Cirl+ N Create a new picture
Cul+0O Open a picture

Cul+ 5 Save changes (o a picture
Curl + Page Up Zoom in

Ctrl + Page Down Zoom out

Ctrl+ B

Bold selected text

Cirl +1 Make selected text italics

Cul +U Underline selected text

Cirl + Num Pad + Scale up and tool or shape

Cirl + Num Pad - Scale down tool or shape

Esc Cancel a selection

Delete Delete a selection

Fll View a picture in full screen mode
Fl12 Save the picture as u new file
Alt-F Opens the File menu

Alt-F4 Close the window
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APPENDIX - II

COMMONLY USED FULL FORMS

BMP : BITMAP PICTURE

CD f COMPACT DISK

CPU . CENTRAL PROCESSING UNIT

DOS : DISK OPERATING SYSTEM

DVD : DIGITAL VIDEO DISK

E COMMERCE s ELECTRONIC COMMERCE

EMAIL : ELECTRONIC MAIL

GB : GIGABYTE

GIF : GRAPHICS INTERCHANGE FORMAT
IBM ] INTERNATIONAL BUSINESS MACHINE
5 : INTEGRATED CIRCUIT

ISP : INTERNET SERVICE PROVIDER

IT - INFORMATION TECHNOLOGY

TPEG z JOINT PHOTOGRAPHIC EXPERTS GROUP
KB : KILOBYTE

MB : MEGABYTE

MODEM ] MODULATER DEMODULATER
MPEG : MOVING PICTURE EXPERTS GROUP
NIC i NETWORK INTERFACE CARD

FB - PETA BYTE

PC - PERSONAL COMPUTER

PNG : PORTABLE NETWORK GRAFPHICS
RAM : RANDOM ACCESS MEMORY

ROM : READ ONLY MEMORY

RTF : RICH TEXT FORMAT

TB i TERABYTE

Ups : UNINTERRUPTIBLE POWER SUPLLY
URL : UNIFORM RESOURCE LOCATER
USB : UNIVERSAL SERIAL BUS

VLSI . VERY LARGE SCALE INTEGRATED CIRCUTT
WWW . WORLD WIDE WEB
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APPENDIX - III

Lab Activity for Typing Practice in English

EXERCISE I

asdfg  ;lkjh  asdfg  ;lkjh  asdfg  lkjh  asdfg Jkijh asdfg
asdfg  :lkjh  asdfg  :kjh  asdfg  :lkjh  asdig kih asdfg
asdfg  lkjh  asdfg  lkjh  asdig  dkjh = asdig dkjh  asdfg
asdfg  ligh  asdfg  :lkjh  asdfg  :dkjh  asdig dkjh  asdfg
asdfg  ;lkjh  asdfg  ;lkjh  asdfg  slkjh  asdfg slkgh asdfg

EXERCISE 11
Ask Fad Alsas Shad Lads Flags Flask
Jag Fag Fall Hash Glad Galls Salad
Jak Had Galf Dash Crall Flash Slash
Sad Lad Adds Lash Hall Lakhs Dhalls
Dad Asks Alas Dall Fall Glass Shall
EXERCISE 1IN

gwert  poiuy (wert  poiuy gwert  poiuy  qwert poiuy  qwerl
poiuy gwert  poiny  (gwert poiuy  gwert  poiuay qwert  poiuy
gqwert  poiuy  qwert  poiny  qwert  poiuy  gwert poiuy  gwert
poiuy  gwert  poiuy  gwert  poiuy  qgwert  poiuy qwert  poiuy
qwert  poiuy qwert  poiuy  qwerlt  poiuy  gwerl poiuy  gwert
poiuy  gwert  poiny  gwert  poiuy  qwert  poiuy qwert  poiuy
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EXERCISE IV

awergfa ;01upy; awerqfa ;01upy; awergfa Lo1upj;
awergfa soiupj; awerqgfa :0iupj; awergfa oiupj;
awerqfa :0iupyj; awerqfa soiupyj; awerqfa ;o1upj;
awergfa soiupj; awerqfa ;oLup]; awerqfa .oiupj;
awerqfa ;0iupj; awergfa s0iupj; awergfa ;oiupj;
EXERCISE V
Figh Dirks Oldest Apple Grade Falls Kodak
Rails Jaded Dead Usual Sales Filed Legal
Lease  Lakes Agile Isles Ahead Larks Roses
Forks Hedge Skill Rupee Grass Would Alpine
Jaded Liked Equip Quail Jokes Asked Walks
Fiddle  Saddle Dead Filed Lakes Lease Legal
EXERCISE VI
azxevl lkmnbj azxevl lkmnby azxevf Ikmnbyj
azxevi lkmnbyj azxevl lkmunbyj azxevf Ikmnbj
azxevl lkkmnbj azxevl lkmnby azxeyl lkmnbj
azxevl liemnbyj azxevl Tkmnbyj azxcvf Tkninbj
azxevt lkmonbj azxcvi Ikmnbj azxevf lkmnbyj
EXERCISE VII
Cat Jack  Colour  Neither Eneny Boat Calcutia
Not Have  Joints Calling Voled Very Vineyard
Met Wind  Nerves  Enlarge Money Move Material
Men  Verb Verbal Somieone  Murry Give Sterling
Bent  Joimt  Jackets — Examine Thousand  Cylinder Assessment
King Carry  Jumbled Examined  Struggle Possible  Beginning
Zeal Night  Booklet  Gracious Grizzled Frequent Meanings
Zero  ‘Tonic  Cutting  Becoming Zodiacal  Exponent  Doubtless
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EXERCISE VI
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EXERCISE IX

Type the following sentences 5 times:
Lost time is never regained
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Get-up early and do your work

Today's youth and tomorrow's old

Age is a virtue when wisdom is with it.

Measure your word before it goes out of you

My steps are measured

A friend in need is a triend indeed

Children are innocent and should be guided rightly.
Our Land has great sages who knew the eternal truth.
Truth never fails

The Quick Brown Fox Jumps Over A Lazy Dog

EXERCISE X

Type the following paragraph 10 times:
Our flag is tri-colour. SAFFRON is the symbol of sacrifice and a string mind. WHITE is
the symbol of purity, love and peace. GREEN is the symbol of plenty and joy. We hoist
and salute our flag. We arc ready o make sacrifices for our country. We want peace and

progress. We want to be pure,
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